
 

 

 

 

 
 
 

 

 
SimuPlant: The Virtual Root 

 User Documentation 
The University of Nottingham 

2013 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                        



   

2 

 

Table of Contents 
Overview ................................................................................................................................... 3 

Model description ................................................................................................................... 4 

Installing SimuPlant: The Virtual Root ..................................................................................... 6 

Requirements .................................................................................................................... 6 

Download .......................................................................................................................... 6 

Running the VirtualRoot Simulator ................................................................................. 6 

Troubleshooting ................................................................................................................ 6 

The Program Interface ............................................................................................................ 7 

Using SimuPlant: The Virtual Root........................................................................................... 9 

Specifying the model .......................................................................................................... 9 

Viewing details of the simulation output ........................................................................ 11 

1. Visualising the simulation ....................................................................................... 11 

2. Viewing multiple panels ......................................................................................... 12 

3. Viewing the simulation output data .................................................................... 13 

Saving the simulation ............................................................................................................ 14 

Saving images of the simulation predictions .............................................................. 14 

Saving the simulation data ........................................................................................... 14 

Creating a new simulation ................................................................................................... 15 

References ............................................................................................................................. 16 

 

  



   

3 

 

Overview 
SimuPlant is a software suite designed to simulate vertex-based models encoded 

within the OpenAlea modelling framework[1]. This user documentation focuses on 

SimuPlant: The Virtual Root, which features multi-cellular models of auxin transport 

within the Arabidopsis root tip, as described by Band et al [2].  

SimuPlant: The Virtual Root enables users with no programming experience to 

simulate auxin dynamics within an Arabidopsis root tip. Users can select from a range 

of model assumptions and choose model and simulation parameter values. Users 

can then simulate the model to investigate how their choices affect the predicted 

distributions of auxin and downstream network components. Simulation results are 

shown visually within the root geometry and can be exported and saved as PNG 

image files. 

SimuPlant is written in Java, and is hence platform independent. It is available from 

www.simuplant.org. 
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Model description 
The plant hormone auxin is an important regulator of plant growth and 

development and plays a key role in organ initiation and tropic responses. Auxin is 

actively transported through plant tissues via proteins on the cell membranes; the 

cellular and subcellular location of these membrane proteins can create auxin 

maxima and directed fluxes. 

SimuPlant: The Virtual Root simulates auxin transport within an Arabidopsis root tip, 

using actual cell geometries. The model predicts the levels of auxin (and 

downstream components) within each cell and apoplast compartment. Within 

each compartment, both protonated and anionic auxin are present, with the 

proportion of each dependent on the compartmental pH. 

The model incorporates  

i. passive diffusion of protonated auxin across cell membranes,  

ii. efflux of anionic auxin (from the cytoplasm to apoplast) mediated by 

members of the PIN family of membrane proteins, 

iii. efflux of anionic auxin (from the cytoplasm to apoplast) mediated by 

members of the PGP family of membrane proteins, 

iv. influx of anionic auxin (from the apoplast to the cytoplasm) mediated by the 

AUX1 membrane proteins, 

v. influx of anionic auxin (from the apoplast to the cytoplasm) mediated by the 

LAX2 membrane proteins, 

vi. passive diffusion of auxin within the apoplast, 

vii. auxin production and degradation within each cell, 

viii. auxin-mediated degradation of the DII-VENUS fluorescent reporter (via the 

network of interactions shown in Fig. 1). 

 

Figure 1: The network of interactions through which auxin degrades DII-VENUS. 
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The distributions of the membrane proteins are prescribed (based on experimental 

images). Users can select from a range of multicellular geometries. In [2], the model 

is used to investigate the role of the AUX1 influx carriers and the available 

geometries correspond to those within this publication. We therefore have 

geometries obtained from wild-type plants, aux1 null mutant plants (in which no 

AUX1 are present) and aux1 J0951>> AUX1 plants (in which AUX1 is only present 

within the elongating epidermal and outer lateral root cap cells). Users have a 

range of options for adjusting the membrane protein distributions, and can change 

the model parameter values. 

Further details of the model and associated equations can be found in [2]. 
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Installing SimuPlant: The Virtual Root 

Requirements 

Java 7 is the only requirement in order to run the application. 

Download 

 The latest version of the SimuPlant GUI is available from www.simuplant.org. 

 A Java 7 runtime installation is also required (available at www.java.com or 

from the system package manager on Linux). 

Running the VirtualRoot Simulator 

Using a command terminal, navigate to the folder where simuplant-root.jar was 

downloaded  to and run the GUI by typing:  

java -jar simuplant-root.jar 

Troubleshooting 

 

If SimuPlant doesn’t run then test the Java installation by typing: 

 
java -version 

 

If the reported version is less than "1.7.0_xx" then Java will need to be upgraded via 

www.java.com or the system package manager for Linux. 

 

On Windows, if Java7 is installed and the command prompt reports that it is unable 

to find java.exe: 

 use Windows Explorer to browse or search for java.exe, generally located at 

C:\Program Files\Java\jre7\bin  or  C:\Program Files(x86)\Java\jre7\bin 

 shift-right-click on the located java.exe file and select "Copy as path" 

 right click on the command prompt, select paste and type " -version" after  it 

and try again. 

 If that succeeds and reports a version, then use that path in place of "java" at 

the command-prompt, ie: 

 
“C:\Program Files\Java\jre7\bin\java.exe" -jar simuplant-root.org 

 

If the computer is connected to a network which uses a web proxy to access the 

internet Java should automatically detect the settings. If this doesn’t happen then 

the user can either: 

 follow the instructions at www.java.com/en/download/help/proxy_setup.xml  

 or modify the java command as follows: 

java -Dhttp.proxyHost=proxy.host.name -Dhttp.proxyPort=8080 -jar simuplant-root.jar 

Replacing ‘proxy.host.name’ and ‘8080’ with the correct address and port. 

  



   

7 

 

The Program Interface 
The SimuPlant interface consists of five major components, as seen in Fig. 2 and 

described below. Full details for using these components are provided in the next 

section.  

 

Figure 2: A standard view of the SimuPlant interface 

1. Model Specification panel 

The Model Specification panel enables the user to select from a choice of root 

geometries, specify model parameter values and choose different options for the 

distributions of the PIN, AUX1 and LAX2 membrane proteins. 

2. Simulation Parameters panel 

The Simulation Parameters panel enables the user to choose the time interval 

and number of time steps for the simulation, and to start and stop the simulation.  

Model Specification 

Simulation Parameters 

Simulation Output Data Task Window 

Simulation Visualisation 
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3. Simulation Visualisation panel 

The Simulation Visualisation panel displays the root geometry, showing the 

distributions of the prescribed or simulated species within the model. Using the 

tool strip at the bottom of the panel, the user can zoom into and out of the 

image, choose to see different species at different time steps, select colour 

mappings for the model outputs and save the simulation figures.   

4. Simulation Output Data 

Users can click particular cells within the root geometry to see the predicted 

concentrations of the different species within this cell; these data are displayed in 

the Simulation Output Data panel. 

5. Task Window 

The Task window displays the current task that is being undertaken by the server. 
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Using SimuPlant: The Virtual Root 

Specifying the model 

On starting SimuPlant, the Model Specification panel displays the ‘Geometry’ tab 

(Fig. 3A). Nine different root geometries are listed, which have been segmented 

from microscope images of wild-type, aux1 and aux1 J0951>>AUX1 plant root tips. 

On selecting a geometry, the server initialises the multicellular root geometry and 

auxin carrier distributions, and loads the auxin transport and DII-VENUS degradation 

models.  As these tasks are completed, they are listed in the Task Window (Fig. 3D). 

 

Figure 3: The Model Specification panel and Task Window 

Having chosen a root geometry, users can view the default model parameters or 

carrier distribution by selecting the relevant tabs within the Model Specification 

panel (Fig. 3). Model parameter choices can be changed by simply deleting and 

replacing the values listed, with the field turning grey when parameter changes are 

registered and the Task Window (Fig 3D) detailing the changes. Users can return to 

the default values by clicking the ‘Reset to default’ button within this tab (Fig. 3B). 

[A] Geometry [B] Parameters 

[C] Carriers [D] Task Window 
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Extreme parameter values can cause the simulation to take excessive time or lead 

to numerical errors. To prevent this we restrict the allowed parameters; if the 

parameter value entered is outside the specified range, the value is automatically 

reassigned to the maximum or minimum of the range. 

The default settings for the Geometry panel depend on the geometry chosen 

(reflecting whether it is from a wild-type, aux1 or aux1 J0951>>AUX1 plant root). 

Selecting different options in this panel enables the user to alter the rules specifying 

the carrier distributions. The distributions of the AUX1, LAX and PIN carriers can be 

seen on the root geometry, within the Simulation Output panel, by using the 

‘Species’ slider to move between the different species within the model.  

 

Specifying the simulation parameters and running the simulation 

Having specified the model parameters, the user can view and alter the number 

and time interval of each time step (in minutes) using the Simulation Parameters 

panel (default parameters are provided) (Fig. 4). The simulation parameters panel 

also shows a progress bar whilst the server is working on completing a task. 

  

Figure 4: The Simulation Parameters panel (A) Before/after a simulation is run (B) While a simulation is 

running 

The simulation is now ready to run by clicking the ‘Run’ button within the Simulation 

Parameters panel. The Task Window lists when each time interval has been 

simulated. While the simulation is running, the ‘Run’ button becomes a ‘Pause’ 

button (Fig. 4B) enabling the user to pause the simulation at any time. Note that on 

the first click of the ‘Run’ button, the Model Specification panel is disabled.  

SimuPlant requires a continual internet connection and we do not recommend using 

it over unreliable wi-fi connections. If the simulator pauses for an excessive time the 

internet connection may have dropped briefly, in which case users should simply 

close the program and restart. 

  

(A) 

(B) 
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Viewing details of the simulation output 

1. Visualising the simulation 

The output of the simulation can be viewed in the Simulation Visualisation panel. The 

evolution of the distributions can be seen by clicking the Play button, or the 

distributions at particular time steps can be viewed using the Time Step slider. Users 

can move the root geometry within the panel by clicking and dragging, and can 

zoom in/out by using the mouse wheel or zoom buttons. 

 

Figure 5: The Simulation Visualisation Panel. 
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Within the Simulation Visualisation Panel, users can: 

i. Use the zoom function to see more details of a particular area of the root 

geometry. 

ii. View the predicted distribution of the different species within the model 

(auxin, TIR1 and DII-VENUS) and the prescribed distributions of the membrane 

proteins using the ‘Species’ slider. 

iii. Use the Colour bar menu to view the simulations using different colour heat 

mappings. 

 

2. Viewing multiple panels 

Users can create and view multiple Simulation Visualisation Panels. Right clicking the 

Simulation tab at the top of the Simulation Visualisation Panel (see Fig 5), the user 

can choose to ‘Select species’ which brings up the box seen in Fig 6. 

 

Figure 6: The Select species box. 

From here, users can select multiple species (using shift-left-click or ctrl-left-click 

[cmd-left-click on a Mac]) and specify the number of columns of Visualisation 

panels required. For example, selecting ‘Auxin’ and ‘DII-VENUS’ and setting the 

column number to be 1, the user can generate the two panels shown in Fig 7. Users 

can change the species and heat map options for each panel, and can remove a 

particular panel by clicking the close button at the top right-hand corner of the 

panel (see Fig 7). 
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Figure 7: View with multiple Visualisation panels. 

 

3. Viewing the simulation output data  

The Simulation Output Data panel (Fig 8) enables users to view the data 

corresponding to any particular cell. Clicking on a cell within the Simulation 

Visualisation panel (within any of the species views) highlights the cell with a dashed 

green outline (see Fig 5). Information about the selected cell is displayed in the 

Simulation Output Data panel. 

 

 

Figure 8: The Simulation Output Data panel. 

 

Close  
button 
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Saving the simulation  
Users can save both the visual predictions of the simulation as images, by using the 

Export menu in the toolbar within each Simulation Visualisation panel, or the 

simulation data which can be uploaded and viewed using SimuPlant. 

Saving images of the simulation predictions 

Users have the option of exporting one or all of the predicted distributions as PNG 

image files. 

Selecting ‘Export one’ saves the image currently shown within the Simulation 

Visualisation panel (which corresponds to a particular species at a particular time 

step). Users select a folder and specify the name of the resulting file in the dialog 

box. 

Selecting ‘Export all’ saves the predicted distributions of the currently selected 

species (as shown in the Simulation Visualisation panel) for each time step, in the 

selected folder. If the user specifies a name in the ‘Save as’ field a new sub-folder 

will be created to hold the images. 

Saving the simulation data 

Users can save the simulation data using the File -> Save Simulation option in the 

menubar. These saved simulations can be reopened for viewing in SimuPlant using 

the File -> Load Simulation option within the menubar. 
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Creating a new simulation  
Users can create a new simulation in three ways: 

i) Clicking the ‘New’ button within the Simulation Parameters panel. This 

deletes the current simulation and returns the program interface to its 

initial configuration (with no geometry selected and the parameter 

values and carrier distributions returned to their default settings). 

ii) In the File menu, the user can select ‘New Simulation’. This also deletes 

the current simulation and returns the program interface to its initial 

configuration. 

  

iii) Clicking the ‘+’ tab at the top of the Simulation Visualisation panel. This 

creates a new tab, containing ‘Simulation 2’, leaving ‘Simulation 1’ 

within the first tab. The Simulation tabs can be deleted, either by 

clicking the ‘x’ within the Simulation tab (see Fig 6) or right clicking the 

Simulation tab and selecting ‘close’. 

In all of these cases, users should then use the geometry tab within the Model 

Specification panel to select a new root geometry for their new simulation. 
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